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1. Purpose: The purpose of this SOP is to describe procedure for Operation and Calibration of

Total Organic Carbon Analyzer.

2. Scope: This SOP is applicable to the following TOC analyzer.
Make Model Serial No. In-house code
Shimadzu

References, Attachments & Annexures:
3.1 References:

3.1.1 Manual of TOC-VcsH, Shimadzu, Japan.
3.2 Attachments:

3.2.1 Attachment I: Calibration Record of TOC

3.2.2 Attachment 2: TOC Check list for sample failure in analysis

3.3  Annexures:

3.3.1 Annexure I: Investigation flow chart
Responsibilities:
4.1  Analyst:

4.1.1 To follow the procedure as per SOP.

4.1.2 To maintain the records as per SOP.
4.2  QC Head or designee:

4.2.1 To check the SOP.

4.2.2 To give the training to all concern persons.
4.3  Quality Assurance:

4.3.1 To check the SOP

4.3.2 To ensure proper implementation of SOP.
4.4  Regulatory Affairs, Quality Head & Plant Head:

4.4.1 To review and approve the SOP.
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5. Distribution:

7.

5.1  Quality Assurance
5.2 Quality Control (Microbiology section)

Abbreviations & Definition of Terms :

6.1  Abbreviations:
6.1.1 TOC Total Organic Carbon
6.1.2 NDIR Non Dispersive Infrared Radiation
6.1.3 KHP Potassium hydrogen phthalate
6.1.4 ppb Parts per billion
6.1.5 UV Ultra—Violet
6.1.6 IC Inorganic Carbon
6.1.7 1D Identification
6.1.8 CO: Carbon Dioxide
6.1.9 IR Infra Red
6.1.10 cc Centimeter cube
6.1.11 C Carbon
6.1.12 L Liter
6.1.13 ASI Automatic Sample injector
6.1.14 Kpa Kilo Pascal
6.1.15 ml Milliliter
6.1.16 OK All correct
6.1.17 Min. Minute
6.1.18 NPOC Non purgeable organic carbon
6.1.19 puL Microliter
6.1.20 SD Standard deviation
6.1.21 CV Coefficient of variance
6.1.22 Mg/L Milligram per liter
6.1.23 USP United States Pharmacopoeia
6.1.24 ppb Parts Per billion
6.1.25 ppm Parts Per million

6.2  Definition of Terms : None

PROCEDURE:
7.1  Principle:

7.1.1 TOC-VcpH converts carbon in the sample to CO». The NDIR uses electromagnetic
radiation or infrared energy to measure this CO,. This measurement is
proportional to the carbon in the sample. Carbon dioxide shows a unique
adsorption spectrum when IR energy passes through it.

7.2 Precautions:
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7.2.1 For best results, change rinsing water daily and store prepared reagents away from
direct sunlight. Use the sucrose and 1,4 Benzoquinone USP refrence standard and
store the same as per recommend storage condition.

7.2.2 Use A grade Borosilicate glassware for sample collection.

7.2.3 Inany case don't rinse the glassware used for TOC analysis with any solvent.

7.2.4 Glassware required for TOC analysis should be cleaned for organic residue,
risinging with 2N nitric acid then with purified water 3-4 times and dry the TOC
sampling container's for 105°C for 30 min.Preferably such glassware should be
maintained separately and to be dedicated for TOC analysis.

7.2.5 At the sample collection point rinse glassware with sample water 3-4 times.

7.2.6  Sample should be analyzed immediately after it is brought to the lab.

7.3  Sampling procedure:

7.3.1 Carry the sampling container (s) and other required accessories to the sampling point
in a tray.

7.3.2 During sampling wear the face mask and hand gloves.

7.3.3  Open the valve of user point and allow the water to flush for at least 30 seconds.

7.3.4 Open the sampling container near to the mouth of sampling point and rinse the
container with the water to be sampled.

7.3.5 During sampling don’t touch the mouth of sampling container and user point.

7.3.6  Carefully fill the water sample up to brim.

7.3.7 Close the sampling container with glass stopper quickly, ensuring that no air gap
remains in the container.

7.3.8 Close the valve and mouth of user point.

7.3.9 Bring the sample in quality control laboratory for analysis.

7.4  Preliminary check:

7.4.1 Check that the instrument and its surrounding are clean, if not clean with a soft
cloth duster.

7.4.2 Ensure that the system is connected to a stabilized power supply and the zero air
cylinder.

7.4.3 Check the levels of dilution water, acid, drain vessel water and humidifier water
each day before starting the instrument and adjust the volume if required with the
respective reagent / solution.

7.5  Preparation of sample:
7.5.1 Put the sample tubing in the sample and cover with parafilm properly.
7.6  Operation:

7.6.1 Switch on the Computer & TOC Instrument.

7.6.2 Double Click on TOC-V Table Editor Icon on desktop.

7.6.3 Enter Password then click Ok, window will open.

7.6.4 Goto Tool Bar, click on “New”. Select H/W Setting window will displayed. Click

on Ok
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7.6.5 Sample Table-TOC-VCPH window will open..

7.6.6 Click on Insert Menu and select Multiple Samples.

7.6.7 Sample Group Wizard (page 1) Sample Source window will displayed. In this
page Select calibration curve. Now browse calibration curves by selecting Browse
button. Calibration Curve Files list window will open, In this calibration file list
select the recently calibration file and then click on open.

7.6.8 Now click on Next in the page 1.

7.6.9 Sample Group Wizard (page 2) Sample Parameters window will displayed.In this
page enter the Number of samples, give the Sample Name and Sample ID then
click on Index Start.

7.6.10 Now click on Finish in the page 2

7.6.11 Enter the Sample ID to be analyzed.

7.6.12 Now click on Connect button on Tool Bar. Sequence window will open.
Instrument will start Initializing. Initilization window will disappear when 100%
initialization is completed.

7.6.13 Now preesure Gauge should show 6 Kg/cm? (200 Kpa) and flow meter should be
150 ml/min. Click on Monitor button on Tool Bar, Background Monitor window
will open.

7.6.14 Wait fir 15 to 20 min for getting the instrument ready condition (see background
conditions like Furnace Temp., Dehumidifier Temp., Baseline Position,
Baseline Fluctuation, Baseline Noise)

7.6.15 When all the lines turns red to green, close the Background Monitor window.

7.6.16 Go to Instrument Menu and click on Maintenance then select Residue
Removal,click on start.click on close after completition.

7.6.17 Go to Instrument Menu and click on Maintenance then select Washing, Washing
window will displayed, click on Select Flow line,Wash Flow Line window will
displayed. Select TC port, IC port OFF lines then click on Washing to start the
washing. Close the window when washing is completed.

7.6.18 Now click on Start from the Tool Bar, Save as Window will open, click on save
Means mode window will open. Select the Normal and click on Ok.

7.6.19 TOC Measurement window will displayed and then click on start.

7.6.20 Either SD or CV area should be in limit.

7.7  System Suitability Test:

7.7.1 System suitability is performed as per USP specifications. USP reference
standards Sucrose and 1,4-Benzoquinone are used as standards.

7.7.2 First calibrate the Instrument after setting the water as Zero ppb (0 ppb) and
Sucrose (500ppb).

7.7.3 Select “New” from the File Menu. Then Click on “Calibration Curve ”

7.7.4 Calibration Curve Wizard (Page 1) System Information window will be displayed,

in this page select the System as TOC-VCPH and click on Next.
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7.7.5 Calibration Curve Wizard (Page 2) Calibration Curve Type window will be
displayed, In this page select the Calibration according to USP/EP and click on
Next.

7.7.6 Calibration Curve Wizard (Page 3) Analysis Information window will be
displayed, in this page select the ananlysis as NPOC and give the Sample
Name(Blank+Sucrose) and Sample ID (Calibration Curve) also give the File
Name for this Calibration Curve template, and then click on Next.

7.7.7 Calibration Curvre Wizard (Page 4) Calibration Measurement Parameters window
will be displayed, In this page see all the Injection parameters are OK. If not, select
them and click Next. The specified parameters are:

Units ppb
Number of injections 3-8
SD 0.5000
CVv 3.0
Number of washes 2.0
Sparge time 0:30 min.
Acid addition 0.5

7.7.8 Calibration Curve Wizard (Page 5) Calibration Points Lists window will be
displayed, In this page Click on Edit and set the Calibration Point Concentration
(500 ppb) for Sucrose then click on ok, again click on Next.

7.7.9 Inthe Calibration Curvre Wizard (Page 6) Additional Settings, Click on Finish.

7.7.10 After creating the calibration file, Select “New” from the File Menu. Then Click
on “Control Sample”.

7.7.11 Control Sample Wizard (Page 1) System Information window will be displayed,
in this page select the System as TOC-VCPH and click on “Next”.

7.7.12 Control Sample Wizard (Page 2) Control Sample Type window will be displayed
In this Page select the “System Suitability Test for USP/EP” also give the File
Name for this Control sample template, and then click on “Next”.

7.7.13 Control Sample Wizard (Page 3) Parameters Sources window will be displayed,
In this page Select the “Calibration Curve” and Browse for the calibration
curve.Select the cal curve and click on “Open”. Click on “Next”.

7.7.14 Control Sample Wizard (Page 4) Analysis Parameters window will be displayed,
In this page select the Analysis as NPOC, give Sample Name (1,4-Benzoquinone)
and sample ID (System Suitability) and then click on Next”.

7.7.15 Control Sample Wizard (Page 5) Injection Parameters window will be displayed

In this Page see all the Injection parameters are Ok. If not, select them and click
Next (‘as mentioned in 7.6.7)
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7.8

7.9

7.10

7.11

7.7.16 In Control Sample Wizard (Page 6) Peak Time Parameters, click on “Next”.
7.7.17 In Control Sample Wizard (Page 7) Control Checking, Click on “Finish”.

7.7.18 Now we have to insert the “Calibration Curve and Control Sample” in table row.
7.7.19 On the Sample Table place the cursor in the row where the Calibration Curve will

be inserted.
7.7.20 From the Insert Menu select Calibration Curve, and the File Name dialog box will
be displayed, select the file name and click on Open. Again go to Insert

Menu select Control Sample, and the File Name dialog box will be displayed,
select the File Name and click on Open.
7.7.21 Now Calibration Curve and Control Sample Sample will be inserted in the sample
table row.
7.7.22 Now Click on “START” from the Tool Bar. Save as Window will be displayed
now click on Save then Means mode Window will Displayed, Select the normal
button and click on OK.
7.7.23 TOC Measurement Window will be displayed, click for start.
7.7.24 Instrument will analyze sample and it will give result Automatically.
7.7.25 Observe the results for calibration curve and system suitability as per above
procedure. The % recovery of system suitability should be between 85% to 115%.
7.7.26 Frequency of system suitability: weekly
Maintenance Checks: The following components should be checked
7.8.1 Carrier gas pressure 6 kg/cm? (200kPa).
7.8.2 Carrier gas flow rate 150ml/min.
Reagent Preparation:
7.9.1 To prepare KHP
7.9.1.1  Weigh 212.5 mg of KHP, add it to a 100ml volumetric flask and make
up the volume 100ml with  pure water (DM water).

7.9.1.2  Take 1 ml of 1000ppm solution of KHP in a 100ml volumetric flask
and make up the volume 100-ml with pure water. This will give 10ppm
solution of KHP.

Calibration

7.10.1 Four Point Calibration: Set the MQ water as zero ppb and prepare 250ppb, 500
ppb and 1000ppb solutions of KHP in MQ water.Do the 4 point calibration by
selecting dilution from standard solution. Prepare a calibration curve using the
above standards and blank as per above explained calibration procedure.
Correlation coefficient (r?) must be greater than 0.980

7.10.2 Frequency of calibration: Monthly

To prepare Sucrose solution:

7.11.1 Dry the USP reference standard Sucrose at 105°C for 60-90 minutes in a hot air
oven and cool to room temperature.Weigh accurately 11.9mg of this sucrose and
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dissolve it in 100 ml volumetric flask. Make up the volume 100ml with pure water.
This gives 50 ppm sucrose solution. Use this solution as a mother solution

7.11.2 Take 1ml of this solution in a 100ml volumetric flask and make up the volume
100ml. This gives 500ppb solution of sucrose.

7.12 To prepare 1,4 Benzoquinone solution:

7.12.1 Weigh 7.5mg of 1,4 Benzoquinone and add it to a 100ml volumetric flask. Make
up the volume 100ml with pure water. This gives 50ppm Benzoquinone solution.

7.12.2 Take 1 ml of this solution in a 100ml volumetric flask and make up the volume
100ml. This gives 500ppb solution of 1,4 Benzoquinone.

7.12.3 Limit: The Total Organic Carbon of purified water must not be more than 500

ppb.
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Attachment - 1
Calibration Record of TOC
Checking of Linearity using Potassium Hydrogen Phthalate

Instrument Name |TOC

Instrument Code Make/Model
Location Calibration frequency |Quarterly =7 days
Calibration date Next Calibration due on

Reagent Batch No. Make / Grade Use Before
Potassium Hydrogen
Phthalate
Water NA

1. Reagent Preparation:
1.1 To prepare KHP

1.1.1 Weigh 212.5mg of KHP, add it to a 100ml volumetric flask and make up
thevolume  100mlwith _ water (DM water).

1.1.2Take _ ml(dml) stock of KHP in a 100ml volumetric flask and make up the
volume _ ml (100ml) with pure water. This will give 10ppm solution.

1.1.3 Prepare a 4 point calibration method in the instrument for the follwing
concentration using the auto dilution procedure, Conc. 0, 250, 500 and 1000ppb
1.1.4 Record the correlation coefficient ( r? ) value for the linearity curve.
Limit NLT 0.980
2. Observation :

Correlation Co - efficient =
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Remark : The instrument is calibrated & qualified / Out of calibration & not qualified for

use.

Calibration : Scheduled / Not scheduled ( Reason :

)

Calibrated By:

Date

Checked By:

Date

Approved By:

Date
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Attachment — 2
TOC Check list for sample failure in analysis

Sampling date:

Sample ID:
S.No. |Check point Complies|Not comply |Remark
1 |Is water blank report
2 | lIs system suitability complies as report
3 |Calibration report
4 | System monitoring
5 |Is TOC sample analysis immediately
6 |Is glassware cleaned where ever required for sampling
and analysis
7 | TOC sampling procedure (Discuss with analyst)
8 |Review the sampling procedure
9 |Resampling of TOC sample( If required)

Remarks by investigator :

Prepared By:

Checked By:

Sign./Date

Sign./Date
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Annexure — 1
Investigation flow chart
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Version No.
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